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Glossary
-B--C--D--E--I--P--S--W-

Following are common computer-related terms with which you may be unfamiliar and which 
are not defined elsewhere in this file.

BMP
This type of file is used to store bitmap (paint type) pictures.

Bytes
Computers store and process information as a series of on (one or white) and off (zero or 
black) instructions. A series of eight on or off instructions is known as a byte (or an ASCII 
character). The number of bytes used in a file determines how much memory and disk 
storage space is required by that file.

Clipboard
When you use the CUT or COPY commands (in the Edit Menu), the currently selected file or 
text is written to a temporary storage location, known as the Clipboard. From the Clipboard, 
the file or text may be PASTED to a different location or imported to another application. See
your Windows documentation for more information regarding the Windows Clipboard.

Directory/Subdirectory
The files on your disks are usually organized into groups known as directories. Each directory
usually contains files related to each other. Directories may also contain other directories 
which are called sub-directories. The directory which contains a sub-directory is known as a 
root directory.

Drag
A mouse action which consists of pressing the left mouse button, and holding the button 
down while moving the mouse to a new position on the screen.

Drop-down Menu
When you click on items in the row of categories displayed just below the NeoSoft Viewer 
title bar, a list of commands and functions will be displayed. You may click on a command or 
function on these lists (menus) to enable it. You may also use the ALT key in combination 
with the underlined letter in the category title to drop down the list of selections.

.EXE, .COM, or .DLL files
These letters following a file's name indicate that the file is used to run a software program.

.ICO
These letters following a file's name indicate the file contains a Windows-type icon image. 
Windows-type icons are limited to 16x16 pixels in size and should use the standard basic 
Windows color palette.

Icon
An icon is a small 32x32 pixel picture representing a commonly used function. Simply click 
on an icon to activate that function.



Path
A file's location on your system is called its "Path." The path consists of the disk drive letter, 
plus the directories and subdirectories needed to go from the disk's root directory to the 
subdirectory containing the file (e.g., a file on the C drive which is contained in the CANDIES 
subdirectory of the COOKBOOK directory would have a path of C:\COOKBOOK\CANDIES\.

Pixel
A pixel is equivalent to a single dot on your screen. A pixel is the smallest unit used for the 
screen resolution being displayed. On a standard computer each pixel is composed of a red, 
a blue and a green phosphor, which are combined to produce the color of the dot.

Selected Area
An area of your icon which has been chosen with either the Scissors tool, or the Select All 
function. This area becomes active, and you may use the Cut, Copy, Delete, Flip Horizontal, 
Flip Vertical, Rotate, Invert and Clear commands to manipulate the selected area. You may 
also move the selected area by placing your mouse cursor within the boundaries of the area 
and dragging it to a new location.

Wildcard characters
These characters are used as placeholders during searches. The asterisk (*) character and 
the question mark (?) are used as wildcard characters. The ? acts as a placeholder for a 
single character, while the * acts as a placeholder for all characters in that position and 
following. E.g., using the string NO?E.T*    to search for    file names would find all files which 
began with NO and which had any character in the third position and had an E in the fourth 
position, and which ended with the letters .T plus any characters following the T (such as 
NOTE.TXT, NOME.TOT or NODE.TNT).



Options: Invert
This option will reverse the colors found in your icon (e.g., black will become white, red will 
become green, etc.) If you use the Scissors tool to choose a specific area, only the selected 
area will be inverted.



Edit: Select All
Use this command to select the entire icon. Once selected, you may use your mouse to drag
the picture to a new area on the drawing surface, or you may use the Copy or Cut 
commands to place the picture onto the Clipboard.



File Selector Browser
The File Browser    aids you when locating files to edit or saving icon files to the disk.

At the top of the dialog is the Location    field, which you may use to specify the path to go 
to. Alternatively, you may scroll through the directories and files shown in the File    window 
(see below) which is situated just below the Location    field.

To the right of the Location    field are three icons. Clicking the icon on the left will toggle 
between placing the drives and directories at the top and bottom of the list of files displayed
in the File    window. The other two icons switch between horizontal and vertical orientation 
for the File    and Preview    windows.

In the File    window, you may double click on a drive letter    to change to that drive, or 
double click on a directory folder    to open that directory.

Double click on the folder pointing left (followed by two dots) to go back one level in the 
directory tree.

Double clicking on the folder which is followed by a backslash (\) will bring you to the 
root directory of the current drive.

Clicking on a filename will select that file and load any compatible icon or a clip from a 
BMP format image. When the desired file is located, use the OK    button to load that 
icon into an editing window. The main editing area can contain several files at the 
same time.

If you wish to see the size, date and other information regarding the files displayed in the
File    window, enable the Show File Details    check box at the bottom of the dialog.

If you know a file's name, you may type it in the File Name    field to bring it into the 
Preview window. If you know a part of the file's name, you may use wildcard characters in 
the File Type    field. If you wish to search through the entire drive for a File Name,    enable 
the Search Entire Drive    function at the bottom of the dialog. You may also limit your file 
list by entering multiple file types separated by spaces (e.g., *.ICO, *.EXE, *.DLL).

When using the Save As function, the File Selector will allow you to specify a new file in 
which to store the icon using the File Name field. You may use the Location    field or the 
File    window to change to a new directory. Alternatively, you may use the File    window to 
browse through your system to find an existing file to replace with the new icon (doing this 
will delete the contents of the original file).

Note: While the Icon Editor can read files from within .EXE and .DLL program files,
you should never attempt to save an icon to a program file, as this will replace 
the program file with a file containing only the icon. The icon editor cannot insert 
a changed icon into a program file, as this could cause the program to become 
unusable.

Use the Cancel    button to abort the Open    function.



File: New
Use this function to load a blank 32x32 pixel page, ready for you to create a new icon. Once 
you have created a New icon, use the Save As function to store it on your disk.



Options: Rotate
This option will rotate the icon in 90 degree increments. If you use the Scissors tool to 
choose a specific area, only the selected area will be rotated.



Registration Screen
If you are running a 30-day evaluation copy of this program, each time you load the program
or when you select the Help/About menu function, you will be given an opportunity to obtain
the current registered version, documentation, technical support and upgrade opportunities. 
Select the Evaluate button to continue to use the program on a trial basis (up to 30 days), or
select the Register button to enter the serial number you received when you purchased the 
package.

If you wish to order the program, you may either call the telephone number listed, or print 
out the order form (using the button provided) and send it via mail or fax to NeoSoft Corp. 
Payment may be made by either check or money order (payable in U.S. Dollars), by major 
credit card (VISA, MasterCard, Discover or American Express), or by institutional purchase 
order (on approved credit).

Select the Cancel    button if you prefer to continue to evaluate the product.

Once you have purchased the product, you will receive the latest version of the product, plus
a number to type into the Serial Number    field. Click on the OK    button after entering the 
product serial number and your (or your company's) name. Once you have entered this 
number, you will not be presented with this screen or with other registration reminders.



Edit: Delete
Use this command in conjunction with the Scissors tool command to erase the selected area 
(If the Select All function has been used, the entire icon drawing will be erased). The area 
which is erased from the icon is not    placed onto the Clipboard, and cannot be Pasted onto 
another area or into another icon.



Window: Cascade
When this option is enabled, icons brought into the editor will be placed into overlapping 
editing windows.



Window: Tile Vertical
When this option is enabled, each icon being edited will be placed into a window which runs 
from the top of the screen to the bottom. Multiple windows will be arranged side by side.



Window: Tile Horizontal
When this option is enabled, each icon being edited will be placed into a window which runs 
across the screen from left to right. Multiple windows will be placed one above the other.



Options: Flip Horizontal
This option will flip the icon from side to side. If you use the Scissors tool to choose a specific
area, only the selected area will be flipped.



File: Open
This command allows you to select  an ICO icon or BMP image to edit from the files on your 
system.



File: Close
This function removes the currently selected icon editing window from the main editing area.
You may also close an icon editing window by using the button on the left side of its title bar.



File: Close All
This function clears the main editing area of all icons being edited or viewed.



File: Save
When you have completed editing your icon, you can use this function to save it as a file on 
your disk. If you choose not to Save your work, it will be lost once the Editor or the icon's 
editing window are closed.

If your icon has not previously been saved, you should use the Save As function to assign a 
name to the file in which your icon will be stored.



File: Exit
This command exits from the NeoSoft Icon Editor program and returns you to Windows.



Edit: Cut
Use this command in conjunction with the Scissors tool command to remove the selected 
area (If the Select All function has been used, the entire icon drawing will be selected). The 
area which is cut out of the icon is placed onto the Clipboard, where it will remain until 
replaced by another Cut  or Copy command. Use the Paste command to place the Cut area 
back onto the icon. The Cut area may also be Pasted onto another icon being edited by 
switching to that icon editing window, and using the Paste    command.



Edit: Undo
This function removes the last change you made to the icon being edited. You may also use 
the Undo    button on the Tool Bar.



Main Editing Area
The Main Editing Area    occupies the large area between the menu and the    tool bar. 

Icon files which are being edited are displayed in individual windows within this area. Each 
editing window contains a large area in which to draw the icon, together with a Zoom control
at the left side of each window. The Zoom control lever allows you to magnify the icon to 
allow you to more easily work on fine details. 

You may move an editing window by dragging its title bar to a new location using your 
mouse. Use the minimize button at the top/right corner of the window to reduce the window 
to an icon (which is a useful way to preview your work-in-progress). Multiple Editing windows
may be arranged in several orientations using the options under the Window menu button.



Tool Bar

Click on a tool to jump to more information

The Tool Bar lies at the bottom of the Editor window, just below the main editing area. Click 
on a tool to use it.

Brush Tool
The brush tool may be used to edit one pixel at a time, or dragged over an area to paint 
freehand. You may paint with both the left and right mouse buttons, each of which may be a 
different color.

Hollow Rectangle
This tool will draw an outline of a rectangle. Begin drawing by moving the mouse to one 
corner of the rectangle, then dragging the mouse to the opposite corner. Use either the left 
or right mouse button to produce an outline color corresponding to the colors shown on the 
Mouse Indicator.

Filled Rectangle
This tool will draw a filled rectangle. Begin drawing by moving the mouse to one corner of 
the rectangle, then dragging the mouse to the opposite corner. Use either the left or right 
mouse button to produce a solid rectangle corresponding to the colors shown on the Mouse 
Indicator.

Hollow Circle
This tool will draw an outline of a circle or ellipse. Begin drawing by moving the mouse to a 
corner, then dragging the mouse to the opposite corner of the area which will contain the 
circle. Use either the left or right mouse button to produce an outline color corresponding to 
the colors shown on the Mouse Indicator.

Filled Circle
This tool will draw a solid circle or ellipse. Begin drawing by moving the mouse to a corner, 
then dragging the mouse to the opposite corner of the area which will contain the circle. Use
either the left or right mouse button to produce a colored circle corresponding to the colors 
shown on the Mouse Indicator.

Line
This tool will draw a straight line. Simply click at the line's starting point and drag the line to 
the ending point. Use either the left or right mouse button to produce a line color 
corresponding to the colors shown on the Mouse Indicator.

Flood Fill
The flood tool may be used to fill a broad areas of one color with another color. Areas of color
consist of pixels which directly adjoin other pixels of the same color along one of their sides. 
Pixels of the same color which merely adjoin at the corners are considered isolated and not 
to be in the same area, unless a path can be made between them through other adjoining 
pixels of the same color. You may flood fill using both the left and right mouse buttons, each 
of which may be a different color.

Scissors



The scissors tool can be used to select an area. To use this tool, simply drag your mouse to 
surround the area which you wish to select. Once you have selected an area, you may move 
it to another area by placing the cursor in the center of the selected area and dragging it to 
another position, or by using the Nudge Tool to move it one pixel at a time. You may also use
the Cut, Copy, Delete, Flip Horizontal, Flip Vertical, Rotate, Invert and Clear functions on the 
selected area.

Text
Use this tool to type text. Simply click the tool at the point where the text is to start, and 
begin typing. While typing, you may change the color of the text by selecting a new color 
from the palette, or you may change the position of the text by dragging it to a new position.
Once you have finished editing your line of text, simply click outside the editing area, or 
choose another tool. If you need to change fonts, use the Set Font function under the 
Options menu. Text color will be the color shown on left button of the Mouse Indicator.

Color Palette
The palette shows the standard colors used for Windows icons. With most tools, you may 
work with two colors by using both the left and right mouse buttons. These colors are 
displayed on the Mouse Indicator. To load the right button color, simply click on the desired 
color using the right mouse button. To change the left button color, click on a color with the 
left mouse button. Note that the color at the extreme right side of the palette is transparent.
The transparent color will allow your Windows desktop to show through underneath your 
icon. While editing, transparent pixels are shown as white with a small dot in the center.

Mouse Indicator
This displays the currently selected colors which will be used when tools are applied using 
the corresponding buttons on your mouse. You may change the colors by clicking with each 
button on the color palette.

Nudge Tool
Use this tool to move either the entire icon, or just a selected area, or an area being pasted, 
one pixel at a time. This makes it easy to make fine adjustments to your icon. Note that if 
you move a portion off the page, that portion will be erased when moved back onto the 
drawing.

Undo Button
Clicking on this button removes the last change you made to the icon being edited. You may 
also use the Undo    function under the Edit menu.



File Select: Image Size

If the image in the file which you wish to Open is larger than the 32x32 pixel size used for 
icons, you will be able to use your mouse to clip a 32x32 area from the larger image (simply 
drag the frame to surround the area which you wish to use as an icon). When you've 
selected the desired area, click on the File Selector's OK    button to import the clip into the 
editor.



Window: Arrange Icons
When resizing the Editor's screen, or when dragging individual icon editing windows, it is 
possible that some windows may go off the screen completely, or that the editing windows 
become jumbled one on top of another. Click on this function to reorder the file icons on 
which you are working.



Help: How to use the Help System
When you click on a Help button    while performing a function, you will be presented with 
information on the purpose of the function and/or how to use it.

You may use the mouse to click on words appearing in [color and underlined] to bring up 
additional explanations or related topics.

Alternatively, you may enter the Help system from the Help    menu button at the top of the 
Icon Editor screen. This will address more general topics.

Once the Help Window appears, you may simply read the message, or use the buttons near 
the top of the window to explore further. If you wish to close the Help window, use the 
File/Exit function, or the button at the top/left corner of the window.

The Contents    button takes you to the opening Help screen, from which you may select
further topics.

The Search    button brings up a window which allows you to select from key words 
contained in the Help file.

The Back    button takes you to the last screen viewed, while the History button lists the 
topics which you've explored thus far (click on a listed topic to return to it).

The Glossary    button displays definitions of uncommon words found in the Help system.

When there are additional topics related to the current Help screen, the << and >> 
buttons allow you to page back and forth between the previous and next pages.



Help Topic Search
This Help Menu function brings up the Search    function of the Help system in a separate 
window.



Help/About
Selecting this function displays information about the NeoSoft Icon Editor and how to contact
NeoSoft Corp. about updates and technical support. If you are running a 30-day evaluation 
version of the program, you will also be presented with a reminder screen.



Options: Set Font ...
Use this function to choose a font from the installed Windows fonts which are present on 
your system. The selected font will be applied when you use the Text tool.



Menu Commands
At the top of the main editing screen are a list of drop-down menus. Select any of the topics 
listed below for more information on how to use the commands in these menus. Drawing 
tools are covered in the section explaining the Tool Bar.

FILE Button
¤        New
¤        Open
¤        Save
¤        Save As
¤        Close
¤        Close All
¤        Exit

EDIT Button
¤        Undo
¤        Cut
¤        Copy
¤        Paste
¤        Delete
¤        Select All
¤        Show Clipboard

OPTIONS Button
¤        Show Grid
¤        Undo On/Off
¤        Set Font ...
¤        Flip Horizontal
¤        Flip Vertical
¤        Rotate 
¤        Invert
¤        Clear

WINDOW Button
¤        Tile Vertical
¤        Tile Horizontal
¤        Cascade
¤        Arrange Icons



¤        Switch Editing Window

HELP Button
¤        Contents
¤        Topic Search
¤        How to use Help
¤        Purchasing Info
¤        Order Form
¤        About



Options: Flip Vertical
This option will flip the icon from top to bottom. If you use the Scissors tool to choose a 
specific area, only the selected area will be flipped.



Edit: Paste
This command places whatever is contained on the Clipboard into your drawing.



Edit: Copy
Use this command in conjunction with the Scissors tool command to copy the selected area 
(If the Select All function has been used, the entire icon drawing will be copied). The area 
which is copied from the icon is placed onto the Clipboard, where it will remain until replaced
by another Copy  or Cut command. Use the Paste command to place the Copied area back 
onto the icon. The Copied area may also be Pasted onto another icon being edited by 
switching to that icon editing window, and using the Paste    command.



Edit: Show Clipboard
This function displays the contents of the Windows Clipboard area. Items are placed on the 
clipboard by using the Cut or Copy commands. Items which are on the clipboard remain 
there until they are replaced by the next Cut or Copy. Once on the clipboard, you may use 
the Paste command to place the item back onto the icon, onto another icon which you are 
editing, or even into a compatible document being edited by another application.



Options: Undo On/Off
This function can be used to enable or disable the Undo feature. Click on the command to 
toggle between enabled (checked) and disabled (no check mark). If you are running on a 
slower system, or are running short of memory resources, disabling the Undo command may
make the editor speedier.



Purchasing NeoSoft Icon Editor
The Icon Editor may be purchased from the dealers listed in the file DEALER.DOC, which is 
included with this program, and from other dealers worldwide. If you cannot find a dealer in 
your area which carries this program, you may print a copy of the order form and purchase 
the program directly from NeoSoft Corp.

NeoSoft may be contacted at:

NeoSoft Corp.
354    NE    GREENWOOD    AVE    SUITE      108
BEND    OR      97701-4631
USA

telephone:    541-389-5489
fax:    541-388-8221
BBS:    541-383-7195
E-mail:    sales@neosoftware.com
WWW site:    http://www.neosoftware.com/~neosft/
CompuServe:    type "GO NEOSOFT" at any "!" prompt

If you have networked systems or would like to purchase the Icon Editor for multiple systems
residing at the same location, you may purchase a network/site license for multiple systems 
at significant savings. Educational institutions are also entitled to an additional 10% discount
on quantity purchases.

NeoSoft Corp. accepts payment by check or money order (drawn in U.S. dollar funds on a 
U.S. bank), VISA, MasterCard, Discover or American Express.



NeoSoft Icon Editor Order Form
To order NeoSoft Icon Editor 1.1, please complete the following form and:

Mail it to: NeoSoft Corp.
354 NE GREENWOOD AVE SUITE 108
BEND OR    97701-4631
USA

Fax it to: 541-388-8221 (24 hrs.)
or call: 541-389-5489 (weekdays 8:00-5:00 Pacific Standard Time)

---------------------------------------------------------------------------------------------------------------------------------
-
1. Enter your name, shipping address and telephone number below:

Name: ___________________________________________________
Company: ___________________________________________________

Address: ___________________________________________________
: ___________________________________________________

City: __________________ State:    __________ Zip: ___________
Country: ___________________________________________________

Telephone: ___________________________________________________
        I heard about NeoSoft's Icon Editor from:      ______________________________

2. Indicate the number of units and shipping method below:

___    Icon Editor for Windows (one user) @ $19.95 each $__________
___    5 User Site License* @ $69.00 $__________
+ shipping:

United States: $5 US Mail, $9 FedEx
Canada/Mexico: $7 Air Mail, $17 FedEx
Other Nations: $12 Air Mail, $19 FedEx $__________

                  (Note that FedEx/UPS cannot deliver to PO Boxes)
=========

TOTAL $__________
* please call NeoSoft Corp. for pricing on other quantities

3. Indicate the payment method below:

___    I've enclosed a check or money order payable to NeoSoft Corp.
(checks must be drawn in U.S. funds on a U.S. bank)

___    VISA                ___    MasterCard                ___    Discover                ___    American Express

Card number: _______________________      Expiration date:    _______

Cardholder's signature: _______________________________________



Window: Switch

If you have several icons loaded into the main editing area, you may use this command to 
switch between editing windows. This is particularly useful when windows are stacked one 
upon another, obscuring those lying underneath.



File: Save As
When you have completed editing your icon, you can use this function to save it as a file on 
your disk. If you choose not to Save your work, it will be lost once the Editor or the icon's 
editing window are closed.

The Save As    function will prompt you to provide a name for the file in which the icon will be
stored. You may provide a name for this file in the File Name: field, or you may use the file 
browser to jump to another directory. If you select a file which already exists, the Editor will 
ask if you are certain you wish to replace the existing file contents with the new icon.

Note that Windows format icons end with the ".ICO" extension to the file's name. If you wish 
to export the icon as a BMP format bitmap image, simply end the filename with the .BMP 
extension.



Print Order Form

The Print  dialog allows you to send the contents of the order form to the print device 
installed in Windows.

The Print What    header gives the currently loaded file's name and shows the 
Windows print device and port to which the file will be sent.

Margins  allows you to adjust the unprinted space around the edge of the paper. Note 
that many printers will not print all the way to the paper edge, and that you may 
have to increase the margin area to avoid cutting off portions of your text. You may 
specify measurements in increments of either Inches    or Centimeters    by clicking 
on the radio buttons on the right side of the dialog. If the file you are printing is an 
image, the margins are not available and the image will be centered on the page.

Header/Footer    allows you to print a line of text at the top and/or the bottom of 
each sheet printed. Use the "&f" code to automatically insert the filename in either 
the header or footer. You may also use the "&p" code to insert page numbers in either
the header or footer text. "&d" will insert today's date, and "&t" will insert the current
time. If you wish to print the "&" character in the header or footer, use "&&".

Other printing Options    allow you to print only a portion of the text which you've 
highlighted, let you print long lines wrapped to fit onto the paper size used in your 
printer, and let you send multiple copies to the printer.

Use the Setup    button to change the orientation, paper source bin or other Windows 
print information. The Print    button begins the printing process, while the Cancel    
button returns you to the Viewer without printing.



Options: Clear
This option will delete all pixels from either the icon or from the selected area of the icon. 
The Cleared area will be transparent.



Option: Show Grid
Enabling this option will cause a grid to be placed over your icon. This makes it easier to 
identify individual pixels within the picture. Note that the grid will not appear in areas which 
have been selected using the Scissors tool or the Select All function.






